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ลิขสิทธิ์  
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ข้อมูลในเอกสารฉบับ นี้อาจมีการเปลี่ยนแปลงโดยไม่ต้อง แจ้งให้ทราบล่วงหน้า ซอฟต์แวร์ที่อธิบายไว้ในเอกสารฉบับนี้ ได้รับการตกแต่งภ ายใต้ข้อตกลง 
ใบอนุญาต หรือข้อตกลงที่ไม่เปิดเผยของซอฟต์แวร์ อาจจะใช้ หรือคัดลอก ที่สอดคล้องกับเง่ือนไขของข้อตกลงเหล่านี่ ซ่ึงเป็นส่วนหนึ่งของเอกสารนี้ จะไม่ 
ทำซ้ำในรูปแบบใด หรือโดยวิธีการใดๆโดยไม่ที่ได้รับอนุญาต เป็นลายลักษณ์อักษรจากบริษัท เอ็นทูเอ็น โซลูชั่น โพรไวเดอร์ จำกัด 
 
เครื่องหมายการค้า 
 

• ABBYY เป็นเครื่องหมายการค้าของ ABBYY 

• Microsoft® และ Windows® เป็นเครื่องหมายการค้าจดทะเบียนของ Microsoft Corporation   

• ชื่ออื่น ๆ และผลิตภัณฑ์ที่ระบุ ในเอกสารฉบับนี้ อาจเป็นเครื่องหมายการค้าหรอื เครื่องหมายการค้าจดทะเบยีนของ บริษัทนั้น ๆ 
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1 ABBYY FineReader PDF 

 เป็นโปรแกรม หรือซอฟต์แวร์ที่ใช้เพื่อการรู้จำ/รู้จับข้อมูลเอกสารภาพ (เอกสารภาพคือ เอกสารที่ได้มาจากการสแกน หรือ ถูกสร้างจาก

ซอฟต์แวร์ประยุกต์ เช่น TIFF และ PDF ตามลำดับ) หรือ หากจะเรียกเป็นภาษาสากลก็คือ OCR (Optical Character Recognition) โดยปกติแล้ว

โปรแกรมจะถูกนำมาใช้บ่อยๆ ในงานแปลงข้อมูลเอกสารภาพให้เป็นข้อมูลข้อความ เพื่อนำผลลัพธ์ที่ได้ไปใช้งานต่อ อาจจะบันทึกในรูปของ .Doc, .Docx 

หรือ ทำให้เป็น Searchable PDF เลยก็ได้ 

เมื่อผู้ใช้งานเปิดโปรแกรม        ABBYY FineReader PDF จะแสดงหน้าตา่งดังรูปภาพแสดงด้านล่าง 

 

 จากรูปภาพด้านบนเมื่อทำการเปิดขึ้นมา ผู้ใช้งานสามารถเลือกใช้งานได้ เช่น เปิด(Open), แสกน(Scan), หรือเปรียบเทียบ(Compare) โดย

ฟังก์ชันด้านซ้ายมือมีบทบาทที่แตกต่างกัน ดังนี้ 

ปุ่มเปิด (Open) คลิกเปิดถ้าผู้ใช้งานมีเอกสารที่ต้องดำเนินการอยู่แล้ว 

ปุ่มแสกน (Scan) สำหรับผู้ใช้งานต้องการสแกนเอกสารที่เป็นกระดาษก่อน 

ปุ่มเปรียบเทียบ (Compare) คลิกเปรียบเทียบหากผู้ใช้ต้องการเปรียบเทียบเอกสารเดียวกันสองเวอร์ชัน 

ปุ่มล่าสุด (Recent) เพื่อทำงานต่อในเอกสาร PDF หรือโปรเจ็กต์ OCR ที่บันทึกไว้ก่อนหน้านี้ 

ปุ่ม Mobile application คลิกแอปพลิเคชันมือถือเพื่อสร้างเอกสารบนสมาร์ทโฟนของผู้ใช้งานโดยใช้ FineReader PDF สำหรับ iOS 
หรือ Android และทำงานกับเอกสารเหล่านั้นบนคอมพิวเตอร์ต่อไป 
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ต่อมาฟังก์ชันการใช้งานด้านขวามือในส่วนแรกจะเป็น Open and Edit 

 

1.1 PDF Document 

ให้กดเลือกที่รูปภาพหรือปุ่มของ PDF Document ตัวเลือกนี้สามารถเรียกไฟล์เอกสาร PDF ขึ้นมาทำการปรับปรุง แก้ไขข้อมูลภายในได้ รวมไปถึง

สามารถพิมพ์เอกสาร หรอื บันทกึข้อมูลสุดท้ายที่ได้รับการไขแล้วออกไปเป็นไฟล์นามสกุลต่างๆ ได้ตามความต้องการ แสดงดังรูปภาพด้านล่าง 

 

• รูปภาพเมนูคำสั่งสำหรับเลือกใช้งานตามความเหมาะสม 
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• รูปภาพแสดงหนา้เอกสาร, บุก๊มาร์ก, ค้นหาคำในเอกสาร, คลิปแนบ, รวมถึงลายเซ็นต์ดิจิทัล                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                      

           

• รูปภาพแสดงการคอมเม้นต์บนเอกสาร 

 

 

 

 

 

• รูปภาพแสดงตัวเลือกการส่งออกผลลัพธ์ไฟล์เอกสาร  

คลิกขวารูปภาพ 

เมื่อใส่คอมเม้นต ์

เมื่อเลือกรูปแบบไฟล์ส่งออก จะแสดงหน้าต่าง

ของโฟลเดอร์บน PC ของผู้ใช้งาน 
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1.2 OCR Editor 

ให้กดเลือกที่รูปภาพหรือปุ่มของ OCR Editor จากนั้นจะแสดงหน้าต่างโฟลเดอร์บน PC ให้ผู้ใช้งานเลือกไฟล์เอกสารที่ต้องการ และกดอัพโหลด 

จากนั้นจะแสดงรายละเอียดการของการ OCR เอกสารทั้งแผ่น ผู้ใช้งานสามารถปรับเปลี่ยนกรอบขอบเขต การตัดสินใจเกี่ยวกับรูปแบบเอาต์พุต 

และการฝึกอบรมภาษาหรือแบบอักษรได้ และผู้ใช้งานยังสามารถออกแบบ Area Template กำหนดให้ OCR เฉพาะจุดที่สนใจได้อีกด้วยจากนั้นจะ

แสดงดังรูปภาพด้านล่าง 

 

หมายเหต ุรายละเอยีดเพิ่มเติมในการใช้งาน สามารถดูได้ในหัวขอ้ถัดไป คลิกทีน่ี้ 

1.3 Convert to 

Convert to เป็นเครื ่องมือสำหรับการแปลงประเภทเอกสาร ไม่ว่าจะเป็น PDF, Microsoft Word, Microsoft Excel หรือ Other Formats 

ผู้ใช้งานสามารถเลือกได้ตามความต้องการ โดยสามารถกดที่รูปไอคอน (แสดงดังรูปภาพด้านล่าง) จากนั้นจะแสดงหน้าต่างของโฟลเดอร์บน PC ให้

ผู้ใช้งานเลือกไฟล์เอกสารและกดนำเข้า 
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• รูปภาพแสดง Convert to PDF 

 

 จากรูปภาพดา้นบน โปรแกรมจะแสดงรายการไฟล์ตัวอยา่งเอกสารที่นำเขา้มา และผู้ใช้งานสามารถตั้งค่าเพิ่มเติมได้ตามฟังก์ชันที่มีทางด้าน 

ซ้ายมือ 

Image quality ตั้งค่าคุณภาพของไฟล์เอกสารที่ต้องการแปลง 

Full-text search เลือกลักษณะที่ต้องการประมวลผล 

OCR languages เลือกภาษาในการประมวลผลให้สอดคล้องกับตัวอย่างไฟล์เอกสาร 

Convert to PDF สร้างไฟล์ PDF (เสร็จสิ้น) 

 

• รูปภาพแสดง Convert to Microsoft Word 
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 จากรูปภาพด้านบน โปรแกรมจะแสดงรายการไฟล์ตัวอย่างเอกสารที่นำเข้ามา และผู้ใช้งานสามารถตั้งค่าเพิ่มเติมได้ตามฟังก์ชันที่มีทางด้าน 

ซ้ายมือ 

Keep formatting เลือกรูปแบบในการแปลงไฟล์เอกสาร 

OCR languages เลือกภาษาในการประมวลผลให้สอดคล้องกับตัวอย่างไฟล์เอกสาร 

Keep pictures เลือกว่าต้องการเก็บรูปภาพ 

Keep headers, footers, and page numbers เลือกว่าต้องการเก็บข้อมูล Header, Footer, Page Numbers 

Convert to Word สร้างไฟล์ Word (เสร็จสิ้น) 
 

• รูปภาพแสดง Convert to Microsoft Excel 

 

จากรูปภาพดา้นบน โปรแกรมจะแสดงรายการไฟล์ตัวอยา่งเอกสารที่นำเขา้มา และผู้ใช้งานสามารถตั้งค่าเพิ่มเติมได้ตามฟังก์ชันที่มีทางด้าน 

ซ้ายมือ 

Keep formatting เลือกรูปแบบในการแปลงไฟล์เอกสาร 

OCR languages เลือกภาษาในการประมวลผลให้สอดคล้องกับตัวอย่างไฟล์เอกสาร 

Keep pictures (XLSX only) เลือกว่าต้องการเก็บรูปภาพ 

Create a separate sheet for each page (XLSX only) สร้าง Sheet แยกแต่ละแผ่น 

Convert to Excel สร้างไฟล์ Excel (เสร็จสิ้น) 
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• รูปภาพแสดง Convert to Other Formats 

 

จากรูปภาพด้านบน โปรแกรมจะแสดงรายการไฟล์ตัวอย่างเอกสารที่นำเข้ามา และผู้ใช้งานสามารถตั้งค่าเพิ่มเติมได้ตามฟังก์ชันที่มีทางด้าน  

ซ้ายมือ 

Select output format เลือกประเภทไฟล์ส่งออก โดยกด Drop-down list 

OCR languages เลือกภาษาในการประมวลผลให้สอดคล้องกับตัวอย่างไฟล์เอกสาร 

Convert to … กดปุ่มสร้างไฟล์ตามที่ผู้ใช้งานเลือก (เสร็จสิ้น) 
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2 ABBYY FineReader OCR Editor 

OCR Editor ใช้เทคโนโลยี Optical Character Recognition สำหรับการแปลงเอสาร PDF และไฟล์รูปภาพ (รวมถึงภาพถ่ายดิจิทัล) ให้เป็นรูปแบบที่

แก้ไขได้ รวมถึงสามารถตรวจสอบข้อความและฝึกโปรแกรมให้จดจำอักษร หรือเรียกว่า Pattern Training นั่นเอง 

การเริ่มต้นใช้งานเม่ือเปิดโปรแกรม         ABBYY FineReader OCR Editor จะแสดงหน้าต่างตามรูปภาพด้านล่าง         

 

แถบเมนูด้านบน เป็นเครื่องมือในการใชง้าน สามารถนำเมาส์ไปวางค้างที่ไอคอนแต่ละรูป จะมหีน้าต่างแสดงขึ้น บอกวา่เครื่องมือตัวนี้ใช้ทำอะไร แสดงดัง

รูปภาพด้านลา่ง 
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แถบเมนูทางด้านซ้ายมือ เป็นเมนูในลักษณะ View ดูภาพรวมทั้ง Page และ Details แสดงดังรูปภาพด้านล่าง 

• แถบ Page 

 

• แถบ Details 

 

ขั้นตอนแรกในการใช้งาน จำเป็นต้องอัพโหลดเอกสารเข้าโปรแกรม ABBYY FineReader OCR Editor ทำได้ 2 วิธี คือ วิธีที่ 1 ไปที่เมนู File> Open 

Image> แสดงหน้าต่างโฟลเดอร์ภายใน PC ให้เลือกไฟล์ที่ต้องการนำเข้า และกด Open แสดงดังรูปภาพด้านล่าง 
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วิธีที่ 2 กดที่เมนู Open จากนั้นจะแสดงหน้าต่างโฟลเดอร์ภายใน PC ให้เลือกไฟล์ที่ต้องการนำเข้า และกด Open แสดงดังรูปภาพด้านล่าง 

 

 

เมื่อผู้ใช้งานเลือกไฟล์เรียบร้อยแล้วจะแสดงรายละเอียดการ OCR เอกสารทั้งแผ่น ผู้ใช้งานสามารถปรับเปลี่ยนกรอบขอบเขต การตัดสินใจเกี่ยวกับ

รูปแบบเอาต์พุต และการฝึกอบรมภาษาหรือแบบอักษรได้ และยังสามารถออกแบบ Area Template กำหนดให้ OCR เฉพาะจุดที่สนใจได้อีกด้วย 

• เมื่อกดนำเข้าไฟล์เอกสาร โปรแกรมจะทำการประมวลแสดงดังรูปภาพด้านลา่ง 
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• เมื่อนำเข้าเสร็จสิ้น จะแสดงดังรูปภาพดา้นล่าง 

 

• Panel 1: แสดงพื้นที่หรือ Area ที่โปรแกรมทำการประมวลผลได้สำหรับไฟล์เอกสารต้นฉบับ  
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• Panel 2: แสดงไฟล์เอกสารทั้งหน้าที่โปรแกรมทำการประมวลผลได้จากไฟล์เอกสารต้นฉบับ  

 

• Panel 3: แสดงไฟล์เอกสารต้นฉบับ เหมือน Panel 1 แต่อยู่ในรูปแบบขยายเพือ่ให้เห็นชัดเจน 
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หลังจากได้มีการนำเข้าตัวอย่างไฟล์เอกสารเรียบร้อยแล้ว โปรแกรม ABBYY FineReader OCR Editor ผู้ใช้งานสามารถตั้งค่าเพิ่มเติมเกี่ยวกับการใช้งาน

เบื้องต้นรวมไปถึงภาษาเป็นต้น บน Options setting โดยเร่ิมต้นให้ไปที่ Tools> Options แสดงดังรูปภาพด้านล่าง 

 

2.1 Options Setting 

เมื่อกดคลิกเข้ามาแล้ว จะแสดงหน้าต่างที่ประกอบไปด้วย แถบ  General, แถบ Image processing, แถบ Languages, แถบ OCR, แถบ 

Format setting, แถบ Areas and text, และแถบ Other แสดงดังรูปภาพด้านล่าง 
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2.1.1 General 

การตั้งค่า General แสดงดังรูปภาพด้านล่าง 

 

▪ When OCR Editor starts ผู้ใช้งานสามารถตั้งค่าได้ว่า เมื่อเริ่มใช้งาน OCR Editor จะให้โปรแกรม 
Open a new OCR project (เปิด OCR project ใหม่ขึ้นมา) หรือ Open 
the last used OCR project (เปิด OCR project ที่ใช้ครั้งล่าสุด)  

▪ Select device for acquiring image เป็นการเลือก Device scanner, Camera ที่ต้องการจะนำรูปภาพมาใช้
งานใน Project 

▪ Set ABBYY FineReader your default 
PDF viewer 

ผู้ใช้งานสามารถตั้งค่า ABBYY FineReader เป็นโปรแกรมดู PDF เริ่มต้น 
ในการดำเนินการนี้ ให้เปิดคุณสมบัติสำหรับไฟล์ PDF ใดๆ ใน Explorer 
และตั้งค่า ABBYY FineReader เป็นโปรแกรมดู PDF เร่ิมต้น 
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2.1.2 Image Processing 

การตั้งค่า Image Processing เป็นการประมวลผลภาพหลังจากนำเข้ามาในโปรแกรมสามารถตั้งค่าได้ดังรูปภาพด้านลา่ง 

 
 

▪ Enable background recognition in the 
PDF Editor 

เมื่อเปิดใช้งานตัวเลือกนี้ หน้าทั้งหมดที่เปิดในโปรแกรมแก้ไข PDF จะถูกจดจำ
โดยอัตโนมัติ กระบวนการนี้ทำงานในพื้นหลังและเพิ่มเลเยอร์ข้อความชั่วคราวลง
ในเอกสาร PDF ทำให้สามารถค้นหาและคัดลอกข้อความได้ ใช้ลิงก์ที่ด้านล่างของ
กลุ่มนี้เพื่อระบุภาษาของเอกสารของผู้ใช้งาน 

▪ Automatically process page images as 
they are added to the OCR Editor 

ตัวเลือกนี้เปิดหรือปิดใช้งานการประมวลผลหน้าที่เพิ่มใหม่โดยอัตโนมัติ หากเปิด
ใช้งานการประมวลผลอัตโนมัติ ผู้ใช้งานสามารถเลือกตัวเลือกการประมวลผล
เอกสารทั่วไปและการตั้งค่าการประมวลผลล่วงหน้าสำหรับรูปภาพที่จะใช้เมื่อ
สแกนและเปิดรูปภาพ 
(Image preprocessing settings) 

- Recognize page images (includes preprocessing and 
analysis): รูปภาพที่เพิ่มใหม่ จะได้รับการประมวลผลล่วงหน้าโดยใช้
การตั้งค่าที่ระบุไว้ในกลุ่มตัวเลือกการตั้งค่าการประมวลผลล่วงหน้า
รูปภาพ 

- Analyze page images (includes preprocessing): ก า ร
ประมวลผลภาพล่วงหน้าและการวิเคราะห์เอกสารจะดำเนินการโดย
อัตโนมัติ แต่ต้องเร่ิม OCR ด้วยตนเอง 

- Preprocess page images: เฉพาะการประมวลผลล่วงหน้าเท่านั้น
ที่จะดำเนินการโดยอัตโนมัต ิแต่ต้องเร่ิมกดวิเคราะห์เอกสาร และ 
OCR ดว้ยตนเอง 
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▪ Image preprocessing settings (apply to 
conversion and OCR) 

ตัวเลือกนี้จะชว่ยให้ผู้ใช้งานสามารถลบข้อบกพร่องทัว่ไปออกจากการสแกนและ
ภาพถา่ยดิจิทัลได้โดยอัตโนมัต ิ

- Use automatic settings: เป็นการตัง้ค่าการใช้งานโดยอัตโนมัต ิ
- Specify settings manually: เป็นการระบุการตั้งค่าโดยผู้ใช้งาน

เอง (คลิกดูข้อมูลเพิ่มเติมแต่ละตัวเลือก) 
- No preprocessing: เป็นการตั้งค่าใหไ้ม่มีการประมวลผลการ

ทำงานล่วงหน้า 

 ข้อมูลเพิ่มเติม: แสดงรายละเอยีดในหัวข้อ Specify settings manually ของแต่ละตัวเลือก ดังนี ้

 

- Split facing pages แยกหนา้เอกสารโดยอัตโนมัติ 
- Correct page orientation ปรับการวางแนวเอกสารโดยอัตโนมัต ิ
- Deskew images การปรับหน้ากระดาษให้ตรง  
- Straighten text lines ปรับบรรทัดข้อความให้ตรง 
- Correct image resolution ปรับความละเอียดของภาพที่ถูกต้อง 
- Detect page edges ตรวจจับขอบหน้ากระดาษและตัดขอบภาพโดยอัตโนมัติ 
- Whiten background ปรับให้พื้นหลังขาวขึ้น 
- Reduce ISO noise ลดค่า Noise ของรูปภาพ 
- Remove motion blur ลบการเบลอของภาพที่เกิดจากการเคลื่อนไหว 
- Correct trapezoid distortions แก้ไขการบิดเบือนเอกสาร 
- Fix inverted colors on image กลับสีของภาพเพื่อให้ขอ้ความสีเข้ม 
- Convert to black and white แปลงข้อมูลให้เป็นขาวดำ 
- Remove color marks ตรวจจับและลบรอยประทบัสีและเครื่องหมาย 
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2.1.3 Languages 

เป็นการตั้งค่าภาษาสำหรับการ OCR เอกสาร ผู้ใช้งานสามารถเลือกตั้งค่าได้มากกวา่ 1 ภาษาขึ้นไป แสดงดังรูปภาพด้านล่าง 

 

▪ Automatically select OCR languages from 
the following list 

เป็นการตั้งค่าภาษาสำหรับ OCR โดยตั้งค่าภาษาอัตโนมัติ 
จากภาพตัวอย ่างค ่าต ั ้ งต ้นของต ัวเล ือกน ี ้ค ือ  English; French; German; 
German (New Spelling); Spanish 

▪ Specify OCR languages manually  เป็นการตั้งค่าภาษาสำหรับ OCR โดยผู้ใช้งานจะต้องระบุภาษาด้วยตัวเอง 
จากภาพตัวอย่างค่าตั้งต้นของตัวเลือกนี้คือ English; Thai; 
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2.1.4 OCR 

การตั้งค่า OCR แสดงดังรูปภาพดา้นล่าง 

 

PDF recognition modes: ตั้งค่าสำหรับเอกสาร PDF ที่มีเลเยอร์ข้อความและรูปภาพเอกสาร PDF ดังกล่าวมักจะสร้างจากเอกสารในรูปแบบที่แก้ไขได้ 

เอกสาร PDF ประเภทอื่นๆ เช่น PDF ที่ค้นหาได้และ PDF แบบรูปภาพเท่านั้น จะได้รับการประมวลผลในโหมด Use OCR เสมอ ซึ่งเป็นโหมดเริ่มต้น

สำหรับ PDF ประเภทเหล่านี้ ไม่จำเป็นต้องตั้งค่าเพิ่มเติมเพื่อประมวลผล PDF ดังกล่าว ผู้ใช้งานสามารถกด drop down list จะแสดงดังรูปภาพด้านล่าง 

   

         

 

▪ Automatically Choose between OCR 
and Text from PDF 

- การเลือกโหมดนี้โปรแกรมจะตรวจสอบเลเยอร์ข้อความและใช้เลเยอร์ข้อความที่มี
อยู่หากมีข้อความคุณภาพดี มิฉะนั้น OCR จะถูกใช้เพื่อสร้างเลเยอร์ข้อความใหม่
ในกรณีที่ข้อความ 

▪ Use OCR 
 

- การเลือกโหมดนี้โปรแกรมจะ OCR และ จะถูกใช้เพื่อสร้างเลเยอร์ข้อความใหม่ 
โหมดนี้ใช้เวลาในการประมวลผลที่นานกว่า เหมาะสำหรับเอกสารที่มีข้อความ
คุณภาพต่ำ 

▪ Use Only Text from PDF - การเลือกโหมดนี้ เป็นโหมดเริ ่มต้นสำหรับเอกสาร PDF ที่มีเลเยอร์ข้อความ 
โปรแกรมจะใช้เลเยอร์ข้อความต้นฉบับโดยไม่ต้องรัน OCR 

OCR speed and accuracy: การตั้งค่าในส่วนนี้สามารถปรับเปลี่ยนความเร็ว, ความละเอยีดในการ OCR แสดงดังรูปภาพดา้นล่าง 
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▪ Thorough recognition ในโหมดนี้ ABBYY FineReader จะวิเคราะห์และจดจำทั้งเอกสารธรรมดาและเอกสารที่มีเค้าโครง
ที่ซับซ้อน ซ่ึงการรับรู้อย่างละเอียดต้องใช้เวลามากขึ้นแต่จะได้คุณภาพที่ดีขึ้น 

▪ Fast recognition 
 

ในโหมดนี้ ABBYY FineReader จะประมวลผลได้อย่างรวดเร็ว แนะนำให้ใช้โหมดนี้สำหรับการ
ประมวลผลเอกสารขนาดใหญ่ที่มีเค้าโครงที่เรียบง่ายและรูปภาพคุณภาพดี จะไม่เหมาะกับเอกสาร
ที่มีความซับซ้อน 

Document type:  ประเภทเอกสารที่ประมวลผล แสดงดังรูปภาพดา้นล่าง 

 

▪ Auto โปรแกรมจะตรวจจับประเภทการพิมพ์โดยอัตโนมัติ (สำหรับเอกสารส่วนใหญ่ โปรแกรมจะตรวจจับประเภทการ
พิมพ์โดยอัตโนมัติ) 
 
 

▪ Fax 
 

ตัวอย่างข้อความที่สร้างโดยเครื่องแฟกซ์ ดังที่เห็นจากตัวอย่าง ตัวอักษรอาจไม่ชัดเจนในบางจุด นอกจากนี้ยังมี
เสียงรบกวนและการบิดเบือนอยู่บ้าง สำหรับข้อความประเภทนี้ ให้เลือก แฟกซ์ 

▪ Typewriter ตัวอย่างข้อความที่พิมพ์ดีด ตัวอักษรทั้งหมดมีความกว้างเท่ากัน (เปรียบเทียบ เช่น "w" และ "t") สำหรับข้อความ
ประเภทนี้ ให้เลือกเครื่องพิมพ์ดีด 
 
 

 

Detection of structural elements: การตรวจจับองค์ประกอบโครงสร้างภายในเอกสารโปรแกรมควรตรวจจับองค์ประกอบโครงสร้างหรือไม่ (ให้

เลือกองค์ประกอบที่จะเก็บรักษาเมื่อส่งออกผลลัพธ์) 

Barcodes: โปรแกรมควรจดจำบารโ์ค้ดหรือไม่สามารถเลือกที่ Convert barcodes into strings 

 

▪ Headers and footers - ส่วนหัวและส่วนท้าย 

▪ Table of contents - สารบัญ 

▪ Numbered lists - การการลำดับเลข 

▪ Footnotes - รูปแบบเชิงอรรถ 
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Use of patterns and training in OCR Editor: การใช้รูปแบบและการฝกึอบรมใน OCR Editor แสดงดังรูปภาพด้านล่าง 

 

▪ Use built-in patterns การใช้รูปแบบในตัว 

▪ Use user patterns การใช้รูปแบบโดยใช้ Patterns ที่ได้ทำการ Training 

▪ Use training to recognize new 
characters and ligatures 

 ใช้การฝึกอบรมเพื่อจดจำตัวละครและตัวอักษรควบใหม่ เลือกคำสั่งซื้อหลังจากนั้นทำ
การ Recognize page โปรแกรมแสดงหน้าต่างให้ทำการ Training ข้อความ  
หลังจากทำการ Training เสร็จสามารถกด Save Patterns and Languages เพื่อทำ
การบันทึกการ Training หรือ สามารถกด Load Patterns and Languages เพื่อทำ
การโหลด Patterns การ Training ที่ผู้ใช้งานทำการบันทึกออกไปได้ 

ส่วนสุดท้ายคือ Select fonts required for the correct display of recognized text: หากต้องการเปลี่ยน Fonts หรือต้องการเลือก Fonts 

เพิ่มเติมให้เลือกที่ Select Fonts 

หมายเหตุ: ดกูารตั้งค่าเพิ่มเติมที่หัวข้อ 2.2 Pattern Training  

2.1.5 Format Settings 

แถบเมนู Format Settings สามารถตั้งค่ารูปแบบต่างๆในการส่งออกเอกสารได้ โดยจะสามารถตั้งค่าได้หลายเอกสาร โดยจะ

สามารถเลือกได้จาก Document Type จะแสดงรายการเอกสารที่สามารถปรับเปลี่ยนได้ โดยแต่ละประเภทเอกสารการตั้งค่า

ต่างๆก็จะแตกต่างกันออกไป 
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2.1.6 Areas and Text 

ผู้ใช้งานจะต้องต้ังค่าเกี่ยวกับการยืนยันข้อมูล การเลือกแบบอักษรสำหรับแสดงข้อความรวมถึงเลือกสีพื้นของประเภทพืน้ที่ต่างๆ 

หน้าต่างแสดงดังรูปภาพด้านลา่ง 

 
  

▪ การตั้งค่าการยืนยัน (Verification settings) ▪ ระบุการตั้งค่าการยืนยันสำหรับอักขระที่มีความมั่นใจต่ำ 
▪ ระบุการตั้งค่าการยืนยันสำหรับคำที่ไม่ใช่พจนานุกรม 
▪ ละเว้นคำที่มีตัวเลขและอักขระพิเศษ 
▪ ตรวจสอบสารประกอบที่ไม่ใช่พจนานุกรม (คำประสมคือคำทีประกอบด้วย

คำตั้งแต่สองคำขึ้นไป) 
▪ ระบุว่าคุณต้องการแก้ไขช่องว่างก่อนและหลังเครื่องหมายวรรตอนหรือไม่ 
▪ ดูและแก้ไขพจนานุกรมผู้ใช้ 

▪ แบบอักษรที่ใช้แสดงข้อความธรรมดา 
      (Font used to display plain text) 

เลือกแบบอักษรสำหรับแสดงข้อความธรรมดา 

▪ เลือกสีวัตถุ (Select object color) เลือกสีและความหนาของเฟรมของประเภทพื้นที่ต่างๆ ในหน้าต่างรูปภาพ สีไฮไลท์
สำหรับอักขระที่มีความมั่นใจต่ำ และตัวเลือกการแสดงผลอื่นๆ 

 

  



คู่มือการใช้งานโปรแกรม ABBYY FineReader PDF V16                                                                 26 

   

สงวนลิขสิทธิ์ © 2567 โดยบริษัท เอ็นทูเอ็น โซลูชัน่ โพรไวเดอร์ จำกัด  

 

2.1.7 Other 

การตั้งค่าอื่นๆ แสดงดังรูปภาพดา้นล่าง 

 
 

▪ ภาษาอินเทอร์เฟซ (Interface language) - ระบุภาษาอินเทอร์เฟซของ ABBYY FineReader PDF 
 

▪ จำนวนแกนประมวลผลที่จะใช้สำหรบั OCR 
(Number of processor cores to use for 
OCR) 

- ระบุจำนวนแกนประมวลผลที่ FineReader ให้ทำการคลิก drop down list  

▪ ตรวจสอบการอัพเดตโปรแกรม (Check for 
program updates) 

- ระบุว่า ABBYY FineReader PDF ควรตรวจสอบและติดตั้งการอัปเดตโดย
อัตโนมัติหรือไม่ 

▪ การดูเอกสารในโปรแกรมแก้ไข PDF (Viewing 
documents in PDF Editor) 

- เปิดหรือปิดการใช้งาน JavaScript ในเอกสาร PDF 
- ระบุว่า ABBYY FineReader PDF ควรตรวจจับ URL ในเอกสาร PDF โดย

อัตโนมัติหรือไม่ 
▪ เรียกคืนการตั้งค่าเริม่ต้น (Restore the ABBYY 

FineReader default settings) 
- คลิก ปุ่มรีเซ็ต (Reset...) ที่ด้านล่างขวามือ หากต้องการเปลี่ยนกลับเป็นการ

ตั้งค่าเร่ิมต้น 
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2.2 Area Template 

2.2.1 Create Area Template 

 การออกแบบ Area ขั้นตอนแรกให้ผู้ใช้งานไปที่แถบเมนู Area> Delete Areas ทำการลบขอบเขตการ OCR บนเอกสารออก

ทั้งหมด เพื่อที่ผู้ใช้งานจะกำหนดสิ่งที่สนใจหรือข้อมูลที่ต้องการ แสดงดังรูปภาพด้านล่าง 

 

เมื่อผู้ใช้งาน Delete Areas ออกทั้งหมดแล้วต่อมาให้ผู้ใช้งานมาทีแ่ถบเครื่องมือด้านบนและเลือกเครื่องมือให้เหมาะสมกับข้อมูล

ภายในเอกสาร จากนั้นคลิกและลากคลมุพื้นที่ข้อมูลที่สนใจ 

 

o Draw Text Area คือเครื่องมือสำหรับส่งออกข้อมูลเป็นประเภทขอ้ความ (Text) 
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o Draw Picture Area คือเครื่องมือสำหรับส่งออกข้อมูลเป็นประเภทรูปภาพ (Picture) 

 

o Draw Table Area คือเครื่องมือสำหรบัส่งออกข้อมูลเป็นประเภทตาราง (Table) 

 

2.2.2 Save Area Template 

หากผู้ใช้งานออกแบบ Area Template เสร็จเรียบร้อยแล้ว ให้เลือกที่แถบเมนู Area> Save Area Template เลือก Path และ

กด Save ผู้ใช้งานจะได้ไฟล์นามสกุล .blkx มาไว้ใช้งานในลำดับถัดไป 
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2.2.3 Load Area Template 

หากผู้ใช้งานต้องการนำไฟล์ Area Template มาใช้งาน หรือ ทำการแก้ไข ให้เลือกแถบเมนู Area> Load Area Template 

เลือก Path และกด Open ไฟล์ ผู้ใช้งานจะได้ Area Template ที่ได้ออกแบบไว้ 

 



คู่มือการใช้งานโปรแกรม ABBYY FineReader PDF V16                                                                 30 

   

สงวนลิขสิทธิ์ © 2567 โดยบริษัท เอ็นทูเอ็น โซลูชัน่ โพรไวเดอร์ จำกัด  

 

 

2.3 Pattern Training 

วิธีการเปิดการใช้งาน Pattern Training ให้ผู้ใช้งานมาเลือกที่แถบเมน ูTools> Options ส่วนที่เกีย่วข้องกับ Pattern Training จะอยู่บน

หัวข้อ Use of patterns and training in OCR Editor แสดงดังรูปภาพดา้นล่าง  

 

1. Use built-in patterns: การใช้รูปแบบในตัว 

2. Use user patterns: การใช้รูปแบบโดยใช้ Patterns ที่ได้ทำการ Training โดยขั้นตอนการเปิดใช้งาน Use user patterns  

ติ๊กเลือกที่ช่อง Use user patterns จากนั้นเลือกที่ Pattern Editor จะแสดงหน้าต่างตามรูปภาพด้านล่าง 
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ให้ผู้ใช้งานทำการเลือก Pattern ที่จะใช้งาน กด Set Active หลังจากนั้นทำการ Recognize page อีกครั้งจะได้ Pattern ที่ผู้ใช้งานได้ทำการเลือกไปเมื่อ

สักครู ่

3. Use training to recognize: ใช้การฝึกอบรมเพื่อจดจำตัวละครและตัวอักษรควบใหม่ แสดงดังรูปภาพด้านล่าง 
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หลังจากนั้นทำการ Recognize Page ใหม่จะแสดงหน้าต่าง Pattern Training ผู้ใช้งานสามารถบอกโปรแกรมได้ว่าอักษรนี้คือตัวอะไรเพื่อทีว่า่

การอ่านครั้งต่อไปโปรแกรมจะได้นำข้อมูลที่ผู้ใช้งาน Training ไปใช้งานเพื่อความถูกต้องของการประมวลผล OCR 

 

 

 

 

 

 

 

 

 

 

ในระหว่างที่ผู้ใช้งานทำการ Training โปรแกรมจะทำการเน้นในส่วนของขอ้ความที่ผู้ใช้งานได้ทำการ Train 

 

 

 

 

 

 

 

 

 

 

เมื่อผู้ใช้งานทำการ Train หากระบุตัวอกัษรผิดหรือใส่ข้อมูลที่ผิด ผู้ใช้งานสามารถเข้าไปแก้ไขได้โดยเข้าไปที ่
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Tools> Options เลือก เมนู OCR จากนั้นทำการเลือกไปที่ Pattern Editor เมื่อทำการคลิกเข้ามาจะแสดงหน้าต่าง Pattern Editor จากนั้นกดที่ Edit 

เพื่อทำการแก้ไข หรือหากจะสร้าง Pattern Training ขึ้นมาใหม่สามาถสร้างได้โดยกดที่ New และทำการ Train  

 

เมื่อทำการคลิกเข้ามาจะแสดงข้อมูลที่ผู้ใช้งานได้ทำการ Train หากมีชุดข้อมูลไหนที่ผิดให้เลือกที่ข้อมูลนั้นๆ เพือ่ทำการแก้ไข จากนั้นเลือกที่ 

Properties จากแสดงหน้าต่างให้ผู้ใช้งานใส่ข้อมูลที่ถูกต้องอีกครั้ง 
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หากผู้ใช้งานต้องการที่จะ Save ข้อมูลที่ได้ทำการ Training เข้าไปที่ Tools> Options เลือกเมนู OCR เลือก Save Patterns and Languages เพื่อทำ

การบันทึกชุดข้อมูลที่ผู้ใช้งานได้ทำการ Training โดยโปรแกรมจะบันทึกเป็นไฟล์ .fbtx และยังสามารถ Load Patterns and Languages มาใช้งานได้อีก

ด้วย  

 

• ตัวอยา่งเมื่อทำการ OCR กอ่นทำการ Training  
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• ตัวอยา่งเมื่อทำการ OCR หลังจากที่ได้ทำการ Training  

 

3 ABBYY Hot Folder 

 เป็นการตั้งค่าการนำเข้าและส่งออกไฟล์อัตโนมัติ โดยจะทำการแปลงเอกสารจากนามสกุลนึง ไปเป็นอีกนามสกุลนึง ขึ้นอยู่กับความต้องการ

ของผู้ใช้งาน ซ่ึงการเริ่มต้นการใช้งาน เมื่อเปิดโปรแกรม            ABBYY Hot Folder จะแสดงหน้าต่างตามรูปภาพด้านล่าง 

 

แถบเมนูด้านบน เป็นเครื่องมือในการใชง้าน สามารถนำเมาส์ไปวางค้างที่ไอคอนแต่ละรูป จะมหีน้าต่างแสดงขึ้น บอกวา่เครื่องมือตัวนี้ใช้ทำอะไร แสดงดัง

รูปภาพด้านลา่ง 
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ขั้นตอนแรกในการตั้งค่าให้โปรแกรมใช้งานได้ คือให้สร้าง Task การทำงานโดยให้กดปุ่ม New จะแสดงหน้าต่าง Task Setting ให้ตั้งชื่อ Task Name 

ตามต้องการแสดงดังรูปภาพด้านล่าง และให้ทำการตั้งค่าตาม Steps ต่อไปนี้ 

 

Step 1: Schedule 

Schedule สามารถเลือกระยะเวลาในการดึงไฟล์เข้ามาประมวลผล โดยมีให้เลือก 2 ชอ่งทางคือ 

1.1 Run once เลือกดึงไฟล์แค่ 1 คร้ังโดยสามารถเลือกวัน เวลาในการดึงไฟล์เข้ามาประมวลผลได้ แสดงดังรูปภาพด้านลา่ง 
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1.2 Recurring เลือกดึงไฟล์แบบเกิดซ้ำๆ โดยสามารถเลือกได้ตั้งแต่เป็นนาที เป็นวนั เป็นสัปดาห์ หรือเป็นเดือน แสดงดังรูปภาพ

ด้านล่าง 

 

Step 2: Open  

ตั้งค่าการนำไฟล์เอกสารเข้ามาประมวลผลซ่ึงสามารถเลือกได้หลายช่องทางตามความเหมาะสมของผู้ใช้งาน 

ช่องทางเลือกที่ 1: นำเข้าผ่านโฟลเดอร์ (Open file from folder)  

ทำการเลือกโฟลเดอร์ที ่ต้องการนำเข้าโดยกดปุ่ม Browse ต่อมาเลือก ประเภทไฟล์หรือไฟล์นามสกุลที่ต้องการให้โปรแกรมดึงเข้ามา

ประมวลผลสามารถ กดปุ่ม Drop down เพื่อเลือกเฉพาะประเภทได้และการตั้งค่าสุดท้ายสามารถเลือกได้ว่าต้องการเก็บไฟล์เอกสารต้นฉบับ

ไว้ หรือให้ลบ หรือรวมถึงต้องการย้ายไฟล์ต้นฉบับที่โดนดึงมาประมวลผลแล้วไปไว้ที่โฟลเดอร์อื่น แสดงดังรูปภาพด้านล่าง 

 

ช่องทางเลือกที่ 2: นำเขา้ผ่าน FTP (Open file from FTP) 

ใส่ Path ในช่อง FTP folder และเลือกประเภทไฟล์หรือไฟล์นามสกุลที่ต้องการให้โปรแกรมดึงเข้ามาประมวลผล สามารถ กดปุ่ม Drop 

down เพื่อเลือกเฉพาะประเภทได้ ต่อมาให้ใส่ Username และ Password สำหรับ FTP Account หรือสามารถ     ติ๊กเลือก ผู้ใช้ที่ไม่ระบุชื่อ 

(Anonymous user) ได้เช่นกัน และการตั้งค่าสุดท้าย สามารถเลือกได้ว่าต้องการเก็บไฟล์เอกสารต้นฉบับไว้ หรือให้ลบ หรือรวมถึงต้องการ

ย้ายไฟล์ต้นฉบับที่โดนดึงมาประมวลผลแล้วไปไว้ที่โฟลเดอร์อื่น แสดงดังรูปภาพด้านล่าง 
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ช่องทางเลือกที่ 3: นำเขา้ผ่าน Outlook (Open file from Outlook) 

ทำการเลือกโฟลเดอร์ที่ต้องการนำเข้าโดยกดปุ่ม Browse ต่อมาเลือกประเภทไฟล์หรือไฟล์นามสกุลที่ต้องการให้โปรแกรมดึงเข้ามาประมวลผล

สามารถกดปุ่ม Drop down เพื่อเลือกเฉพาะประเภทได้และการตั้งค่าสุดท้าย สามารถเลือกได้ว่าต้องการเก็บไฟล์เอกสารต้นฉบับไว้ หรือย้าย

ไปยังโฟลเดอร์อื่น หากกดเลือกย้ายไปโฟลเดอร์อื่น สามารถเลือกเพิ่มเติมได้ว่าต้องการคัดลอกไฟล์ไว้บนโฟลเดอร์บน PC ได ้

 

ช่องทางเลือกที่ 4: นำเขา้ผ่าน OCR Project (Open file from OCR Project) 

เป็นการนำเข้าผ่าน OCR Project ให้กดปุ่ม Browse ได้เลย 
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Step 3: Process (Analyze and recognize images) 

 เป็นการตั้งค่าการประมวลผลเอกสาร สามารถตั้งค่าได้ดังนี้ 

ตั้งค่าภาษา สามารถเลือกได้มากกวา่ 1 ภาษา ใหก้ดปุ่ม Edit 

ตั้งค่าการประมวลผลเอกสาร เลือกการประมวลผลเอกสาร 

ตั้งค่าลบหน้าว่าง ตั้งค่าการให้ลบหน้าว่างอัตโนมัติหรือย้ายไปยังโฟลเดอร์อื่น โดยกด Browse เลือกโฟลเดอร์ที่ต้องการ 

ตั้งค่าการวิเคราะห์เอกสาร ทำการเลือกว่าให้วิเคราะห์พื้นที่โดยอัตโนมัติ หรือใช้เทมเพลตที่มีอยู่ (*.blkx;*.blk) 

 

Step 4: Save 

 สามารถเลือกส่งออกไฟล์ผลลัพธ์ไปเป็น OCR โปรเจ็ค, ไฟล์รูปภาพ, ไฟล์เอกสาร, หรือแชร์พ้อย และสามารถเลือกส่งออกได้มากกว่า 1 

ตัวเลือกตามรูปภาพด้านลา่ง  
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การตั้งค่าภายในหน้าต่างตัวเลือก 
Save OCR project 

 
การตั้งค่าภายในหน้าต่างตัวเลือก 
Save images 

 
การตั้งค่าภายในหน้าต่างตัวเลือก 
Save document 

 
การตั้งค่าภายในหน้าต่างตัวเลือก 
Save to SharePoint 
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เมื่อทำการตั้งค่าเสร็จแล้วให้กดปุ่ม Create Task จากนั้น Task ทีผู่้ใช้งานสร้างจะปรากฎบนหน้าแรก แสดงดังรูปภาพด้านล่าง เป็นอันเสร็จสิ้น

กระบวนการ 
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4 ABBYY Compare Document 

เป็นการเปรียบเทียบความแตกตา่งระหว่างเอกสาร ให้ผู้ใช้งานเปิดโปรแกรม           ABBYY Compare Document จะแสดงหน้าต่างดังภาพด้านล่าง 

 

จากหน้าต่างที่แสดงจะเห็นว่า แบ่งเป็น 2 ฝั่งชัดเจน ซ่ึงในการนำเข้าเอกสารมาประมวลผลสามารถทำได้ด้วยกัน คือ  

1. กดที่รูปเอกสาร จะแสดงหน้าต่างของโฟลเดอร์ภายใน PC ให้ทำการเลือกไฟล์เอกสารที่ต้องนำมาเปรียบเทียบ 

2. กดที่รูปไอคอนโฟลเดอร์ด้านบนจะแสดงหน้าต่างของโฟลเดอร์ภายใน PC ให้ทำการเลือกไฟล์เอกสารที่ต้องเช่นเดียวกันให้ทำการเลือกเอกสารที่

ต้องการเปรียบเทียบ เมื่อกดนำเข้าเอกสารแล้ว จะแสดงดังรูปภาพด้านล่าง 

 
 เมื่อนำเข้าเรียบร้อยให้ทำการตั้งค่าที่ เมนูแถบด้านขวามือ คือการตั้งค่าภาษา ให้ตั้งค่าภาษาตามหน้าเอกสารที่นำเขา้มาประมวลผล และกดปุ่ม 

Compare เมื่อกดปุ่มแล้วจะแสดงดังรูปภาพดา้นล่าง 
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• รูปที่ 1: แสดงตัวอยา่งที่ไม่มีความแตกตา่งกันและจะมขี้อความแจ้งเตือนวา่ “No differences have been found” 

 
 

• รูปที่ 2: แสดงตัวอย่างที่มีการเปรียบเทียบกันและมีจุดที่แตกต่างกัน แสดงดังภาพด้านล่าง และจะสังเกตุว่าโปรแกรมแจ้งเตือนให้ทราบว่า มีจุดที่

แตกต่างกันอยู่ 2 จุดโดยมีข้อความแจ้งเตือนว่า “Differences found: 2” และรายละเอียดจะแสดงดังหน้าต่างทางด้านขวามือ 

 
 

 เมื่อทำการเปรียบเทียบเสร็จสิ้นสามารถกดบันทึกไฟล์ได้โดยกดที่ปุ่ม Save ด้านบนและเลือกตำแหน่งที่ต้องการวางไฟล์บน PC รวมถึงกด

บันทึก ข้อมูลการเปรียบเทียบได้ โดยเลือกที่ปุ่ม Save และเลือกคำสั่ง Comparison Report    
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5 ABBYY Screenshot Reader 

เป็นการแคปรูปภาพหนา้จอหรอืหน้าตา่งและส่งออกเป็น Text, Table, หรือ Image ไปยังแอปพลิเคชันที่ต้องการ โดยสามารถเลือกได้ตามความต้องการ 

โดยมีวธิีการใช้งานดังนี ้

• ทำการเปิด ABBYY Screenshot Reader      เมื่อเปิดขึ้นมาแลว้จะมหีน้าต่างตามรปูภาพดา้นล่าง  

 

5.1 Capture 

เป็นขั้นตอนแรกในการเริ่มดำเนินการ โดยสามารถเลือกได้ว่าจะทำการแคปหน้าจอโดยวิธีการใด โดยมี 4 ทางเลือกให้ใช้งานคือ 

Area ตั้งค่าคุณภาพของไฟล์เอกสารที่ต้องการแปลง 

Window เป็นการเลือกจับภาพเฉพาะส่วนของหน้าจอ (เช่น หน้าต่าง ส่วนหนึ่งของหน้าต่าง หรือแถบเครื่องมือ) 

Screen เป็นการจับภาพทั้งหน้าจอ 

Timed Screen เป็นการจับภาพหน้าจอหลังจากหน่วงเวลา 5 วินาที 
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5.2 Language 

เป็นการเลือกภาษาของข้อความที่ตอ้งการส่งออกไปยังปลายทาง สามารถเลือกได้ 1 ภาษาหรือมากกว่า 1 ภาษา โดยหากต้องการเลือก

มากกว่า 1 ภาษาใหก้ดที่ปุ่ม More languages… 

 

5.3 Send 

 เลือกส่งออกภาพที่ทำการตรวจจับ ว่าตอ้งการส่งออกไปยังแอปพลิเคชันใด โดยสามารถเลือกได้ทั้งหมด 10 ช่องทาง ดังนี้ 

 

• เมื่อทำการตั้งค่าเสร็จสิ้นแล้ว ใหก้ดที่ปุม่                  เพื่อเป็นการเริ่มต้นการทำงานของโปรแกรม 
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5.4 Example of how the program works 

หากผู้ใช้งานต้องการใช้แค่ข้อมูลส่วนใดส่วนหนึ่งบนเอกสารก็สามารถคลิกแล้วลากคลุมในส่วนที่สนใจได้เลย  เมื่อลากคลุมเสร็จเรียบรอ้ยแล้ว 

ให้กดคลิก Capture เพื่อให้โปรแกรมเริ่มทำการประมวลผลข้อมูล 

 

ผลลัพธ์จากการประมวลผลมีดังนี้ 

Text to Clipboard เมื่อโปรแกรมประมวลผลเสร็จสิ้นให้ทำการคลิกขวา Paste หรือ Ctrl + V ใน Notepad เพื่อตรวจสอบความถูกต้อง
ก่อนนำไปใช้งาน 
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Text to File เมื่อโปรแกรมประมวลผลเสร็จสิ้นโปรแกรมจะแสดงให้ผู้ใช้งานเลือกบันทึกเป็นไฟล์ 
ประเภทต่างๆ ตามรูปภาพดา้นล่าง 

 

 

 

 

 

 

Text to Microsoft Word เมื่อโปรแกรมประมวลผลเสร็จสิ้นโปรแกรมจะทำการเปิด Microsoft Word แล้ววางข้อมูลที่
ผู้ใช้งานสนใจให้อัตโนมัติ 
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หากผู้ใช้งานต้องการใช้ข้อมูลในสว่นที่เป็นตารางตามรูปภาพตัวอย่างด้านลา่ง 

 

 

ผลลัพธ์จากการประมวลผลมีดังนี้ 

 

 

Table to Clipboard เมื่อโปรแกรมประมวลผลเสร็จสิ้นให้ผู้ใช้งานคลิกขวา Paste หรือ Ctrl + V ใน Notepad หรือ 
Microsoft Word เพือ่ตรวจสอบความถูกต้องก่อนนำไปใช้งาน 



คู่มือการใช้งานโปรแกรม ABBYY FineReader PDF V16                                                                 49 

   

สงวนลิขสิทธิ์ © 2567 โดยบริษัท เอ็นทูเอ็น โซลูชัน่ โพรไวเดอร์ จำกัด  

 

 

 

 

 

 

 

 

 

 

Table to Microsoft Excel เมื่อโปรแกรมประมวลผลเสร็จสิ้นโปรแกรมจะทำการเปิด Microsoft  Excel แล้ววางข้อมูลที่
ผู้ใช้งานสนใจให้อัตโนมัติ 
 

Image to Clipboard เมื่อโปรแกรมประมวลผลเสร็จสิ้นให้ผู้ใช้งานคลิกขวา Paste หรือ Ctrl + V ใน Microsoft Word 
หรือ โปรแกรมสำหรับแก้ไขรูปภาพ การทำงานของ  Image to Clipboard จะเหมือนการ  
Screenshot รูปภาพบนคอมพิวเตอร์ 
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Image to File เมื่อโปรแกรมประมวลผลเสร็จสิ้นโปรแกรมจะแสดงให้ผู้ใช้งานเลือกบันทึกเป็นไฟล์รูปภาพ
ประเภทต่างๆ ตามรูปภาพดา้นล่าง 

 

Image to E-mail เมื่อโปรแกรมประมวลผลเสร็จสิ้นโปรแกรมจะแสดงไปยังหน้าต่างส่งข้อความทาง E-mail พร้อม
รูป Screenshot  ที่ผู้ใช้งานสนใจ 
 


